Note the following details of the code protection feature on Microchip devices:

- Microchip products meet the specification contained in their particular Microchip Data Sheet.
- Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the intended manner and under normal conditions.
- There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip’s Data Sheets. Most likely, the person doing so is engaged in theft of intellectual property.
- Microchip is willing to work with the customer who is concerned about the integrity of their code.
- Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.

Information contained in this publication regarding device applications and the like is provided only for your convenience and may be superseded by updates. It is your responsibility to ensure that your application meets with your specifications. MICROCHIP MAKES NO REPRESENTATIONS OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY OR OTHERWISE, RELATED TO THE INFORMATION, INCLUDING BUT NOT LIMITED TO ITS CONDITION, QUALITY, PERFORMANCE, MERCHANTABILITY OR FITNESS FOR PURPOSE. Microchip disclaims all liability arising from this information and its use. Use of Microchip’s products as critical components in life support systems is not authorized except with express written approval by Microchip. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual property rights.

Trademarks

The Microchip name and logo, the Microchip logo, Accuron, dsPIC, KeeloQ, microID, MPLAB, PIC, PICmicro, PICSTART, PRO MATE, PowerSmart, rfPIC, and SmartShunt are registered trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

AmpLab, FilterLab, MXDEV, MXLAB, PICMASTER, SEEVAL, SmartSensor and The Embedded Control Solutions Company are registered trademarks of Microchip Technology Incorporated in the U.S.A.

Analog-for-the-Digital Age, Application Maestro, dsPICDEM, dsPICDEM.net, dsPICworks, ECAN, ECONOMONITOR, FanSense, FlexROM, fuzzyLAB, In-Circuit Serial Programming, ICSP, ICEPIC, Migratable Memory, MIPASM, MPLIB, MPLINK, MPSIM, Pickit, PICDEM, PICDEM.net, PICLAB, PICtail, PowerCal, PowerInfo, PowerMate, PowerTool, rFLAB, rFICDEM, Select Mode, Smart Serial, SmartTel and Total Endurance are trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

All other trademarks mentioned herein are property of their respective companies.

© 2004, Microchip Technology Incorporated, Printed in the U.S.A., All Rights Reserved.

Printed on recycled paper.

Microchip received ISO/TS-16949:2002 quality system certification for its worldwide headquarters, design and wafer fabrication facilities in Chandler and Tempe, Arizona and Mountain View, California in October 2003. The Company’s quality system processes and procedures are for its PICmicro® 8-bit MCUs, KeeloQ® code hopping devices, Serial EEPROMs, microperipherals, nonvolatile memory and analog products. In addition, Microchip’s quality system for the design and manufacture of development systems is ISO 9001:2000 certified.
Table of Contents

Preface ......................................................................................................................... 1

Chapter 1. Introduction
  1.1 Introduction ..................................................................................................... 7
  1.2 Highlights ........................................................................................................ 7
  1.3 Functional Features ........................................................................................ 7
  1.4 System Requirements .................................................................................... 8
  1.5 Software Components .................................................................................... 8

Chapter 2. Installation
  2.1 Introduction ..................................................................................................... 9
  2.2 Highlights ........................................................................................................ 9
  2.3 System Resources ........................................................................................... 9
  2.4 Installation Procedure ................................................................................... 10
  2.5 Uninstall Procedure ...................................................................................... 12

Chapter 3. Overview
  3.1 Introduction ................................................................................................... 13
  3.2 Highlights ...................................................................................................... 13
  3.3 Word Library Builder Overview ..................................................................... 13

Chapter 4. Build Process
  4.1 Introduction ................................................................................................... 17
  4.2 Highlights ...................................................................................................... 17
  4.3 Overview ........................................................................................................ 17
  4.4 Word Selection ............................................................................................. 18
  4.5 Word Training ............................................................................................... 19
  4.6 Create Output Files ......................................................................................... 21
  4.7 Editing Word Libraries .................................................................................. 23

Chapter 5. Commands
  5.1 Introduction ................................................................................................... 25
  5.2 Highlights ...................................................................................................... 25
  5.3 Main Menu .................................................................................................... 25
  5.4 Toolbar .......................................................................................................... 26

Chapter 6. Word Selection
  6.1 Introduction ................................................................................................... 27
  6.2 Highlights ...................................................................................................... 27
  6.3 Word Library Considerations ........................................................................ 27
Preface

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and
documentation are constantly evolving to meet customer needs, so some actual dialogs
and/or tool descriptions may differ from those in this document. Please refer to our web site
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each
page, in front of the page number. The numbering convention for the DS number is
“DSXXXXX”, where “XXXXX” is the document number and “A” is the revision level of the
document.

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help.
Select the Help menu, and then Topics to open a list of available on-line help files.

INTRODUCTION

The dsPIC30F Speech Recognition Word Library Builder helps users build the speech
recognition vocabulary for a voice controlled application embedded on a dsPIC30F
Digital Signal Processor. This manual is used in conjunction with the dsPIC30F Speech
Recognition Library User’s Guide (DS70140). Items discussed in this chapter include:

• Document Layout
• Conventions Used in this Guide
• Warranty Registration
• Recommended Reading
• The Microchip Web Site
• Development Systems Customer Change Notification Service
• Customer Support
This user’s guide provides step-by-step instructions for installing and operating the dsPIC30F Speech Recognition Word Library Builder on a PC or laptop computer. The document is organized as follows:

- **Chapter 1: Introduction** – This chapter introduces the dsPIC30F Speech Recognition Word Library Builder and defines the minimum system support requirements.
- **Chapter 2: Installation** – This chapter provides instructions for installing the dsPIC30F Speech Recognition Word Library Builder.
- **Chapter 3: Overview** – This chapter provides a high-level explanation of the role of the word library as a component of the dsPIC30F Speech Recognition Library.
- **Chapter 4: Library Building** – This chapter provides detailed procedures for creating and training a word library and preparing library files to interface with an embedded application.
- **Chapter 5: Commands** – This chapter provides a reference source for the menu and toolbar commands used by the dsPIC30F Speech Recognition Word Library Builder.
- **Chapter 6: Selecting an Appropriate Word Library** – This chapter provides information to help users choose an effective vocabulary for their speech recognition user interface.
- **Appendix A: Master Library** – This appendix lists the vocabulary that can be used for verbal control of the user's application.
- **Appendix B: Sample Libraries** – This appendix contains sample word libraries for a number of typical speech controlled applications.
CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

### DOCUMENTATION CONVENTIONS

<table>
<thead>
<tr>
<th>Description</th>
<th>Represents</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arial font:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Italic characters</td>
<td>Referenced books</td>
<td><em>MPLAB IDE User's Guide</em></td>
</tr>
<tr>
<td></td>
<td>Emphasized text</td>
<td><em>...is the only compiler...</em></td>
</tr>
<tr>
<td>Initial caps</td>
<td>A window</td>
<td>the Output window</td>
</tr>
<tr>
<td></td>
<td>A dialog</td>
<td>the Settings dialog</td>
</tr>
<tr>
<td></td>
<td>A menu selection</td>
<td>select Enable Programmer</td>
</tr>
<tr>
<td>Quotes</td>
<td>A field name in a window or dialog</td>
<td>“Save project before build”</td>
</tr>
<tr>
<td>Underlined, italic text with right angle bracket</td>
<td>A menu path</td>
<td>*File&gt;*Save</td>
</tr>
<tr>
<td>Bold characters</td>
<td>A dialog button</td>
<td>Click OK</td>
</tr>
<tr>
<td></td>
<td>A tab</td>
<td>Click the <em>Power</em> tab</td>
</tr>
<tr>
<td>‘bnnnn’</td>
<td>A binary number where <em>n</em> is a digit</td>
<td>b00100, ‘b10</td>
</tr>
<tr>
<td>Text in angle brackets &lt; &gt;</td>
<td>A key on the keyboard</td>
<td>Press &lt;Enter&gt;, &lt;F1&gt;</td>
</tr>
<tr>
<td>Courier font:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plain Courier</td>
<td>Sample source code</td>
<td><em>`define START</em></td>
</tr>
<tr>
<td></td>
<td>Filenames</td>
<td><em>autoexec.bat</em></td>
</tr>
<tr>
<td></td>
<td>File paths</td>
<td><em>c:\mcc18\h</em></td>
</tr>
<tr>
<td></td>
<td>Keywords</td>
<td><em>_asm, _endasm, static</em></td>
</tr>
<tr>
<td></td>
<td>Command-line options</td>
<td><em>-Opa+, -Opa-</em></td>
</tr>
<tr>
<td></td>
<td>Bit values</td>
<td>0, 1</td>
</tr>
<tr>
<td>Italic Courier</td>
<td>A variable argument</td>
<td><em>file.o</em>, where <em>file</em> can be any valid filename</td>
</tr>
<tr>
<td>0xnnnn</td>
<td>A hexadecimal number where <em>n</em> is a hexadecimal digit</td>
<td>0xFFFF, 0x007A</td>
</tr>
<tr>
<td>Square brackets [ ]</td>
<td>Optional arguments</td>
<td><em>mcc18 [options] file [options]</em></td>
</tr>
<tr>
<td>Curly brackets and pipe character: {</td>
<td>Choice of mutually exclusive arguments; an OR selection</td>
<td>*errorlevel {0</td>
</tr>
<tr>
<td>Ellipses...</td>
<td>Replaces repeated text</td>
<td><em>var_name [, var_name...]</em></td>
</tr>
<tr>
<td></td>
<td>Represents code supplied by user</td>
<td><em>void main (void) { ... }</em></td>
</tr>
</tbody>
</table>

### WARRANTY REGISTRATION

Please complete the enclosed Warranty Registration Card and mail it promptly. Sending in the Warranty Registration Card entitles users to receive new product updates. Interim software releases are available at the Microchip web site.
RECOMMENDED READING

This user's guide describes how to use dsPIC30F Speech Recognition Library. Other useful documents are listed below. The following Microchip documents are available and recommended as supplemental reference resources.

Readme for dsPIC30F Speech Recognition Library
For the latest information on using dsPIC30F Speech Recognition Library, read the "Readme for dsPIC30F Speech Recognition Library.txt" file (an ASCII text file) in the doc subdirectory of the Speech Recognition Library installation directory. The Readme file contains update information and known issues that may not be included in this user's guide.

dsPIC30F Family Reference Manual (DS70046)
Consult this document for detailed information on dsPIC30F device operation. This reference manual explains the operation of the dsPIC30F MCU family architecture and peripheral modules but does not cover the specifics of each device. Refer to the appropriate device data sheet for device-specific information.

dsPIC30F Programmer's Reference Manual (DS70030)
This manual is a software developer's reference for the dsPIC30F 16-bit MCU family of devices. This manual describes the instruction set in detail and also provides general information to assist users in developing software for the dsPIC30F MCU family.

dsPIC30F Family Overview (DS70043)
This document provides an overview of the functionality of the dsPIC product family. Its purpose is to help determine how the dsPIC 16-bit Digital Signal Controller Family fits a specific product application. This document is a supplement to the dsPIC30F Family Reference Manual.

dsPIC30F Data Sheet, Motor Control and Power Conversion Family (DS70082)
Consult this document for detailed information on the dsPIC30F Motor Control and Power Conversion devices. Reference information found in this data sheet includes:

- Device memory map
- Device pinout and packaging details
- Device electrical specifications
- List of peripherals included on the device

dsPIC30F5011, dsPIC30F5013 Data Sheet, High Performance Digital Signal Controllers (DS70116)
This data sheet contains specific information for the dsPIC30F5011/5013 Digital Signal Controller (DSC) devices.

dsPIC30F6011, dsPIC30F6012, dsPIC30F6013, dsPIC30F6014 Data Sheet, High Performance Digital Signal Controllers (DS70117)
This data sheet contains specific information for the dsPIC30F6011/6012/6013/6014 DSC devices.

MPLAB ASM30, MPLAB LINK30 and Utilities User's Guide (DS51317)
This document includes detail on Microchip Technology's language tools for dsPIC® devices based on GNU technology. The language tools discussed are:

- MPLAB ASM30 Assembler
- MPLAB LINK30 Linker
- MPLAB LIB30 Archiver/Librarian
- Other Utilities

This document includes details on Microchip’s MPLAB C30 C compiler for dsPIC devices to develop an application. MPLAB C30 is a GNU-based language tool, based on source code from the Free Software Foundation (FSF). For more information about the FSF, see www.fsf.org.

Other GNU language tools available from Microchip are:

- MPLAB ASM30 Assembler
- MPLAB LINK30 Linker
- MPLAB LIB30 Librarian/Archiver

MPLAB IDE Simulator, Editor User's Guide (DS51025)

Consult this document for more information pertaining to the installation and implementation of the MPLAB Integrated Development Environment (IDE) Software.

THE MICROCHIP WEB SITE

Microchip provides online support via our WWW site at www.microchip.com. This web site is used as a means to make files and information easily available to customers. Accessible by using a favorite Internet browser, the web site contains the following information:

- **Product Support** – Data sheets and errata, application notes and sample programs, design resources, user’s guides and hardware support documents, latest software releases and archived software
- **General Technical Support** – Frequently Asked Questions (FAQ), technical support requests, online discussion groups, Microchip consultant program member listing
- **Business of Microchip** – Product selector and ordering guides, latest Microchip press releases, listing of seminars and events, listings of Microchip sales offices, distributors and factory representatives
DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip products. Subscribers will receive e-mail notification whenever there are changes, updates, revisions or errata related to a specified product family or development tool of interest.

To register, access the Microchip web site at www.microchip.com, click on Customer Change Notification and follow the registration instructions.

The Development Systems product group categories are:

- **Compilers** – The latest information on Microchip C compilers and other language tools. These include the MPLAB C17, MPLAB C18 and MPLAB C30 C compilers; MPASM™ and MPLAB ASM30 assemblers; MPLINK™ and MPLAB LINK30 object linkers; and MPLIB™ and MPLAB LIB30 object librarians.

- **Emulators** – The latest information on Microchip in-circuit emulators. This includes the MPLAB ICE 2000 and MPLAB ICE 4000.

- **In-Circuit Debuggers** – The latest information on the Microchip in-circuit debugger, MPLAB ICD 2.

- **MPLAB IDE** – The latest information on Microchip MPLAB IDE, the Windows® Integrated Development Environment for development systems tools. This list is focused on the MPLAB IDE, MPLAB SIM and MPLAB SIM30 simulators, MPLAB IDE Project Manager and general editing and debugging features.

- **Programmers** – The latest information on Microchip programmers. These include the MPLAB PM3 and PRO MATE® II device programmers and the PICSTART® Plus development programmer.

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

- Distributor or Representative
- Local Sales Office
- Field Application Engineer (FAE)
- Technical Support
- Development Systems Information Line

Customers should contact their distributor, representative or field application engineer (FAE) for support. Local sales offices are also available to help customers. A listing of sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support@microchip.com

In addition, there is a Development Systems Information Line which lists the latest versions of Microchip’s development systems software products. This line also provides information on how customers can receive currently available upgrade kits.

The Development Systems Information Line numbers are:

1-800-755-2345 – United States and most of Canada
1-480-792-7302 – Other International Locations
Chapter 1. Introduction

1.1 INTRODUCTION

The dsPIC30F Speech Recognition Word Library Builder is a software tool that allows users to generate a word library and related speech recognition data files for the dsPIC30F Speech Recognition Library.

1.2 HIGHLIGHTS

This chapter discusses:
- Functional Features
- System Requirements
- Software Components

1.3 FUNCTIONAL FEATURES

The dsPIC30F Speech Recognition Library simplifies the development process for a voice-activated user application by providing a predefined list of control words. The dsPIC30F Speech Recognition Word Library Builder lets users choose the specific vocabulary for their application and train the library for their operating environment (see Figure 1-1).

FIGURE 1-1: WORD LIBRARY BUILDER OVERVIEW

The dsPIC30F Speech Recognition Word Library Builder is used to:
- Create a custom library of words selected from the Master Library.
- Train the library based on the noise environment of the application.
- Build specific data files used by the dsPIC30F Speech Recognition Library in an application, including an optional sample utterance used for testing.
1.4 SYSTEM REQUIREMENTS

The dsPIC30F Speech Recognition Word Library Builder runs on a PC platform with these minimum performance characteristics:

- PC-compatible 386 or newer
- 16 MB memory (32 MB recommended)
- 16 MB hard disk space (20 MB recommended)
- Microsoft Windows® 98, Windows NT®, Windows 2000 or Windows XP operating system.

1.5 SOFTWARE COMPONENTS

The dsPIC30F Speech Recognition Word Library Builder is distributed on a product CD. The following components are included:

- dsPIC30F Speech Recognition Word Library Builder program
- Speech database containing word models for the dsPIC30F Speech Recognition Master Library
Chapter 2. Installation

2.1 INTRODUCTION

This chapter provides instructions for installing the dsPIC30F Speech Recognition Word Library Builder on a PC or laptop computer.

2.2 HIGHLIGHTS

Information presented in this chapter includes:

- System Resources
- Installation Procedure
- Uninstall Procedure

2.3 SYSTEM RESOURCES

The dsPIC30F Speech Recognition Word Library Builder requires the following resources on a PC:

- Disk Space: 0.7 MB minimum for Word Library Builder components
- Disk Space: 15 MB minimum for Speech Database components
2.4 INSTALLATION PROCEDURE

The Word Library Builder is packaged on a CD. It can also be purchased and downloaded from the Microchip web site. To install the library follow these steps:

1. Insert the CD into the appropriate drive and start the setup procedure. If the program is downloaded from the Microchip web site, run WLBsetup.exe from the download location. The Word Library Builder installation screen displays, as shown in Figure 2-1.

FIGURE 2-1: INSTALLATION WELCOME SCREEN

2. Click Next > on the Welcome dialog, then review and accept the License (see Figure 2-2).

FIGURE 2-2: SOFTWARE LICENSE AGREEMENT SCREEN
3. Specify where to install the program files and the folder for the program icons as shown in Figure 2-3.

**FIGURE 2-3: FILE LOCATION AND SETUP DIALOGS**

Select a folder for the program, then click **Next >**

Accept or change location for icons, then click **Next >**
4. Installation progress displays briefly as the files are installed, then the Setup Complete dialog displays, as shown in Figure 2-4.

FIGURE 2-4: SETUP COMPLETE DIALOG

5. Click Finish.

2.5 UNINSTALL PROCEDURE

To uninstall the dsPIC30F Speech Recognition Word Library Builder:

1. From Start select Settings > Control Panel.
2. From the Control Panel window, select Add/Remove Programs.
4. Follow the Windows uninstall procedures.
3.1 INTRODUCTION

The dsPIC30F Speech Recognition Library allows users to include an audio user interface in an embedded control application on the dsPIC30F Digital Signal Processor while using only a modest amount of program and data memory. The dsPIC30F Speech Recognition Word Library Builder prepares the data files that are used for recognition.

3.2 HIGHLIGHTS

This chapter discusses:
- Word Library Builder Overview
- Master Library
- Word Library
- Noise Profile
- Memory Profile

3.3 WORD LIBRARY BUILDER OVERVIEW

The dsPIC30F Speech Recognition Library allows the user to control an application by uttering discrete words into a microphone. The word library is a predefined list of command words that are relevant to both the application program and the user. Upon recognition of a word, the application program takes a corresponding action.

The dsPIC30F Speech Recognition Word Library Builder is used to select appropriate words from a master word library and train the library for the specific noise environment of an application, as depicted in Figure 3-1.

FIGURE 3-1: WORD LIBRARY BUILD PROCESS

Words appropriate for controlling the user application are selected from the Master Library – 100 common command words. From the list of selected words, a keyword is designated. This keyword is used to test the library and can also be used to initiate speech recognition. The word list is then given a library name and saved.

Next the ambient sound condition of the application environment is profiled by identifying the noise type (white, car or office noise) and the signal-to-noise ratio (SNR). The word library is then trained for the defined noise profile. The training process results in a Vector Codebook (VCB) appropriate for the noise profile, a Hidden Markov Model (HMM) for each word and a test utterance file.
3.3.1 Master Library

The master library is currently a list of 100 common words that have been identified by research and testing as effective in speech recognition applications. Based on this master list, Vector Codebook characteristics have been identified and catalogued in the dsPIC30F Speech Recognition Word Library Builder to be used in a wide range of noise profiles.

The words that comprise the master library are listed in Appendix A. “Master Library”.

3.3.2 Word Library

The Word Library is the list of words users select from the master library. Each word library is a file with the extension ‘swl’ (e.g., [filename].swl). The file name is the name chosen when the library is saved.

The word library can contain up to 100 words, but they must be chosen from the Master Library. In deciding which words to include in the word library users should avoid selecting words that sound alike. For example, using “step” and “stop” in the same library could lead to incorrect responses in the application.

It is a good idea to avoid a large word library. Aside from the obvious benefit of less memory required, a smaller word library generally improves accuracy. In other words, sounds that don’t match words in the word library are easily rejected as not supported. Advice on selecting an appropriate vocabulary for a speech recognition user interface is given in Chapter 6. “Word Selection”. A number of sample word libraries are listed in Appendix B. “Sample Libraries”.

3.3.3 Keyword

One word in the library must be designated as a keyword. The primary purpose of the keyword is to activate speech recognition. For example, an application might require the end user to utter the keyword before the Speech Recognition Library will recognize any other word in the library. This feature allows the application library to ignore all other words until the keyword is uttered. A secondary purpose of the keyword is to provide testing support. A sample utterance of the keyword can be stored in memory and used to test the hardware audio path of a system. The sample utterance is useful for development, but may not be practical for an end application.

Both features of the keyword are optional and enabled from the Speech Recognition Library API (defined in the Speech Recognition Library User’s Guide). Even if users choose not to use the keyword features in their application, they must still select a keyword to enable Word Library training.

3.3.4 Noise Profile

The word library also includes a noise profile that takes into account the audio background environment of the user application. Background interference can include white noise, office noise and passenger compartment (car) noise components in any mixture. The noise profile is defined by the type of noise and the signal-to-noise ratio. The total signal-to-noise ratio should be no less than 15 dB. A signal level above the noise threshold is presumed to be an incoming word.

The noise profile is an attribute of the training process. It determines parameters for selecting a “best match” Vector Codebook, which in turn is used to generate HMM word models for each word in the word library. During the training process, a sample utterance of the keyword is chosen for recognition self-testing.
3.3.5 Memory Profile

Training settings also allow the Vector Codebook, HMM library and keyword utterance to be allocated to either program memory, internal to the dsPIC30F device, or external memory. To help users decide how to allocate memory, the size of the corresponding output files is estimated and displayed before training is started.

Average memory requirements are as follows:
Hidden Markov Model – 1536 bytes for each word in word library
Vector Codebook – 8096 bytes
Keyword data file – determined by size of the keyword utterance
The actual file sizes are determined after training is completed.

Note: For information on the memory requirements of the dsPIC30F Speech Recognition Library executable, see the *dsPIC30F Speech Recognition Library User’s Guide* (DS70140).
Chapter 4. Build Process

4.1 INTRODUCTION

The dsPIC30F Speech Recognition Library provides an audio interface for controlling an embedded application on the dsPIC30F Digital Signal Processor. This chapter provides step-by-step instructions for creating the vocabulary for the audio interface using the dsPIC30F Speech Recognition Word Library Builder.

4.2 HIGHLIGHTS

Information in this chapter includes:
- Overview
- Word Selection
- Word Training
- Create Output Files
- Editing Word Libraries

4.3 OVERVIEW

There are three primary tasks involved in building a word library, as summarized in Figure 4-1.

**FIGURE 4-1: WORD LIBRARY BUILDING PROCESS**

1. Select specific words from the Master Library, identify the keyword and name the word library.
2. Define the noise profile of the application environment and train the word library for this environment
3. Create the interface files needed by the dsPIC30F Speech Recognition Library and the user application.

**Note:** It is recommended that a separate folder be set up for each word library built. Keeping libraries in separate folders allows them to be more easily maintained.
4.4 WORD SELECTION

Follow these steps to create a new word library.

1. Launch Word Library Builder (see Figure 4-2).

FIGURE 4-2: WORD LIBRARY BUILDER OPEN SCREEN

2. Select File>New. The Master Library list displays, as shown in Figure 4-3.

FIGURE 4-3: MASTER LIBRARY LIST

3. Select the words desired from the Master Library (right window pane) and use the left arrow key to move them to the Word Library (left window pane). The selected words are marked in the Master Library and are listed in the Word Library.

4. After building the Word Library list, choose and double click the keyword. The keyword icon is noted with a red center.
5. Select **File>Save As**. The Save Word Library dialog displays, as shown in Figure 4-4.

**FIGURE 4-4: SAVE AS DIALOG**

6. Create a new folder, then save the word library in this library.

**Note:** Consider using the same name for the folder and word library. For example, if users want to name their word library *MyLibrary*, create a folder named *MyLibrary*, then save the word library in that folder.

### 4.5 WORD TRAINING

After the word library is built and saved, it must be trained for the specific noise profile of the application environment. This process determines which Vector Codebook offers the best matching characteristics for the selected words and noise profile. In turn, the selected Vector Codebook is used to train the Hidden Markov Model for each word. And finally, a sample test utterance of the keyword is created.

The Noise profile is defined by the signal-to-noise ratio between the sound utterance and the background noise level. The background noise can be defined as percentages of the basic noise types – White, Car and Office.

Pre-defined noise profiles and their characteristics are listed in Table 4-1. If operating in an environment with no noise, select the White – 50 dB noise profile to perform library training.

**TABLE 4-1: PRE-DEFINED NOISE PROFILES**

<table>
<thead>
<tr>
<th>Profile</th>
<th>SNR level (dB)</th>
<th>Noise type (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>White</td>
<td>Car</td>
</tr>
<tr>
<td>1 (White – 50 dB)</td>
<td>50</td>
<td>100</td>
</tr>
<tr>
<td>2 (White – 15 dB)</td>
<td>15</td>
<td>100</td>
</tr>
<tr>
<td>3 (Car – 15 dB)</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>4 (Office – 15 dB)</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>5 (White/Car – 15 dB)</td>
<td>15</td>
<td>50</td>
</tr>
<tr>
<td>6 (White/Office – 15 dB)</td>
<td>15</td>
<td>50</td>
</tr>
<tr>
<td>7 (Car/Office – 15 dB)</td>
<td>15</td>
<td>0</td>
</tr>
<tr>
<td>8 (Mixed – 15 dB)</td>
<td>15</td>
<td>34</td>
</tr>
</tbody>
</table>
Follow these steps to train the word library:

1. Select **Training>Train Word Library**. The noise profile dialog displays (Figure 4-5).

**FIGURE 4-5: LIBRARY NOISE PROFILE DIALOG**

![Training Word Library: Test](image)

2. Choose either **User** or **Standard** noise profile type.

   - If **Standard** is chosen, the drop-down list is active, and one of the pre-defined profiles can be selected.
   - If **User** is chosen, the custom profile data boxes are active and profile information must be entered. A user defined noise profile allows the assignment of arbitrary SNR levels and noise types within these defined limits:
     - The signal-to-noise ratio of any one noise component can be between 15 dB and 50 dB.
     - The sum of percentages for all noise types (White + Car + Office) must equal 100% (e.g., see Mixed Profile in Table 4-1).

3. Click **Start**. The noise profile dialog extends to display the training progress, then a message dialog displays **Training is Completed!** (Figure 4-6)

4. Click **OK**.

**FIGURE 4-6: TRAINING COMPLETE MESSAGE**

![Training is completed!](image)

**Note:** The training process creates an intermediate file ([filename].sdf) that is used to create the output files (Section 4.6).
4.6 CREATE OUTPUT FILES

The final task in building a word library is to create the output files needed to interface with the dsPIC30F Speech Recognition Library and the embedded user application. Output files are created with the base name ([filename]) of the word library and saved in the folder created for the library when the library was named (see Section 4.4 “Word Selection”). There are four files generated by the library training process:

- [filename]_int.s – Data files for the Vector Codebook, Hidden Markov Models and the Keyword sample that are allocated to internal memory.
- [filename]_ext.s – Data files for the Vector Codebook, Hidden Markov Models and the Keyword sample that are allocated to external memory.
- [filename].h – Header file that contains a set of constants for each word in the word library. This file is used to interpret the value returned by the SR_Recognizer() function in the dsPIC30F Speech Recognition Library.
- [filename]_voc.s – Data file that contains the ASCII string of each word in the library. This file is used with the dsPIC30F Speech Recognition Library demonstration program to display the actual library word on the LCD on the dsPICDEM 1.1 Develoment Board.

Note: The dsPIC30F family of digital signal processors does not have a dedicated external memory bus. However, an external, non-volatile memory can be interfaced to the dsPIC30F using general purpose I/O pins. The speech recognition library supports an external memory interface that is suitable for testing the library on the dsPICDEM1.1 Development Board. See the dsPIC30F Speech Recognition Library User's Guide (DS70140) for more information on using this interface.
Follow these steps to create the output files:

1. Select *Training>Create Data*. The memory allocation dialog opens (Figure 4-7).

2. Decide if the keyword test utterance file should be included.
   - To include the test utterance file, check either internal or external.
   - To exclude the test utterance file, leave both memory selections unchecked.

3. Allocate the Vector Codebook to either internal or external memory.

4. Decide how to allocate the HMM word model files. All the files can be placed in internal or external memory, or the files can be split with some internal and some external. Use the radio buttons to fix all word models to a memory location. Use the directional [<<} and [>>] arrow keys to distribute the HMM across both memories.

5. Click **OK**. The output files are created.

6. When the completion message displays (Figure 4-8), click **OK**.

---

**FIGURE 4-7: MEMORY ALLOCATION DIALOG**

![Memory Allocation Dialog](image)

**FIGURE 4-8: CREATE DATA COMPLETION MESSAGE**

![Create Data Completion Message](image)
4.7 Editing Word Libraries

The dsPIC30F Speech Recognition Word Library Builder allows the modification of existing word libraries. Words can be added or deleted. The keyword can be changed. The noise profile can be changed. And, the internal and external memory usage can be re-allocated. Follow these steps to edit a word library:

1. Launch Word Library Builder and open the library to be edited. The Word Library Builder displays the requested library (see Figure 4-9).

   The Window title bar displays the name of the word library.

   The title bar at the top of the window pane indicates the number of words in the library and the designated keyword.

   The status bar at the bottom of the window indicates the current noise profile and the amount of memory used by the Vector Codebook (CB), the Hidden Markov Models (HMM) and the Keyword data file (KW).

FIGURE 4-9: WORD LIBRARY DISPLAY SCREEN

2. Select View>Edit.

   The edit window displays the word library and master library side by side.

3. Decide what action to take:

   Add a word to the library (see Section 4.7.1 “Add Words”).

   Delete a word from the library (see Section 4.7.2 “Delete Words”).

   Delete a word library (see Section 4.7.3 “Delete a Word Library”).

   Change the word library noise profile (see Section 4.7.4 “Change Word Library Noise Profile”).

   Re-allocate memory usage (see Section 4.7.5 “Re-Allocate Memory Usage”).

   **Note:** Any changes made to an existing library require the user to re-train the library and re-create the output files.
4.7.1 Add Words
1. Select the word to be added from the master library.
2. Add it to the word library using the left arrow [<] key.
3. Repeat steps 1 and 2 as necessary. Use the <Ctrl> or <Shift> key to select multiple words, or drag the cursor to select multiple adjacent words.
4. Save the file.

4.7.2 Delete Words
1. Select the word to be deleted from the word library.
2. Delete the word from the library using the right arrow [>] key.
3. Repeat steps 1 and 2 as necessary, or use the <Ctrl> or <Shift> key to select multiple words.
4. Save the file.

4.7.3 Delete a Word Library
All of the words in a library can be deleted and an empty library file retained on the PC (for example, a test file). Or a word library can be totally deleted.

To delete library words and retain the word library file:
1. Select all the words in the word library.
2. Send them back to the master library.
3. Save the file.

To totally delete the word library file:
1. Locate the library folder on the hard drive.
2. Delete all the output files.
3. Delete the file folder.

4.7.4 Change Word Library Noise Profile
1. With the word library open, select Training>Train Word Library.
2. Select the noise profile type and corresponding parameters.
3. Click Start.
4. Create new output files.

4.7.5 Re-Allocate Memory Usage
1. With the word library open, select Training>Create Data.
2. Allocate memory usage as appropriate for the application (see Section 4.6 “Create Output Files”).
3. Click OK
4. When the completion message displays, click OK
Chapter 5. Commands

5.1 INTRODUCTION

This chapter provides a cross reference between dsPIC30F Speech Recognition Word Library Builder menu commands and available toolbar icons and keyboard shortcuts.

5.2 HIGHLIGHTS

Information in this chapter includes:

- Main Menu
- Toolbar

5.3 MAIN MENU

Table 5-1 lists the commands generated from the main menu and correlates the menu functions with available shortcut keys.

<table>
<thead>
<tr>
<th>TABLE 5-1: MAIN MENU COMMANDS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command</td>
</tr>
<tr>
<td>---------</td>
</tr>
<tr>
<td><strong>File Menu</strong></td>
</tr>
<tr>
<td>New</td>
</tr>
<tr>
<td>Open</td>
</tr>
<tr>
<td>Save</td>
</tr>
<tr>
<td>Save As</td>
</tr>
<tr>
<td>Close</td>
</tr>
<tr>
<td>Exit</td>
</tr>
<tr>
<td><strong>View Menu</strong></td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>Refresh</td>
</tr>
<tr>
<td><strong>Training Menu</strong></td>
</tr>
<tr>
<td>Train Word Library</td>
</tr>
<tr>
<td>Create Data</td>
</tr>
<tr>
<td><strong>Help Menu</strong></td>
</tr>
<tr>
<td>Help Contents</td>
</tr>
<tr>
<td>About</td>
</tr>
</tbody>
</table>
5.4 TOOLBAR

Figure 5-1 correlates the toolbar icons with the main menu commands.

FIGURE 5-1: dsPIC30F SPEECH RECOGNITION WORD LIBRARY BUILDER TOOLBAR
Chapter 6. Word Selection

6.1 INTRODUCTION

The success of a speech recognition user interface is highly dependent on the words used to control the application. The dsPIC30F Speech Recognition Library limits the possible vocabulary to 100 words to optimize recognition accuracy. This chapter offers advice on selecting an appropriate vocabulary for a speech recognition user interface.

6.2 HIGHLIGHTS

This chapter discusses:

- Word Library Considerations
- Word Selection
- Library Size
- Application Design Tips

6.3 WORD LIBRARY CONSIDERATIONS

The dsPIC30F Speech Recognition Library has been developed to yield the highest possible accuracy. However, recognition accuracy depends on a number of factors:

- Correct pronunciation of words by the speaker
- Speaker's voice quality
- Ambient noise levels
- Size of the HMM library
- Similarity of words in the library

For example, recognition accuracy could diminish for the following reasons:

- The signal level is too low or too high.
- The signal is too noisy (SNR < 15 dB).
- Words in the library sound alike.

Many of these parameters are largely out of the developer's control. However, there are two items that the developer must seriously consider when creating a word library. These are the words selected for the library and the size of the library.

6.3.1 Word Selection

The words selected for the word library have the greatest impact on recognition accuracy. Since the dsPIC30F Speech Recognition Library provides a speaker-independent solution, it is intended to accommodate a broad spectrum of users without requiring users to “train” the speech recognition logic. Users of a finished product will appreciate this valuable convenience.

To provide high accuracy for all speakers of American English, speech data was collected from a large, equally-weighted demographic sampling of the American population. This data was then processed by speech recognition experts with the assistance of a world-class linguistic facility, to ensure the highest possible accuracy for the library.
Although a tremendous effort was made to build and test the word models used by the speech recognizer, there are certain limitations that the library may not be able to overcome. Since some words in the library sound very similar, it is possible for the speech recognizer to confuse these words, depending on how they are pronounced.

The word pairs shown in Table 6-1 have demonstrated inconsistencies in speech recognition; i.e., one word is sometimes recognized as the other. It is recommended that these word pairs not be used together in the same library.

**TABLE 6-1: WORD PAIRS TO AVOID**

<table>
<thead>
<tr>
<th>Word</th>
<th>Poorly Matched Words</th>
</tr>
</thead>
<tbody>
<tr>
<td>arm</td>
<td>on</td>
</tr>
<tr>
<td>balance</td>
<td>down</td>
</tr>
<tr>
<td>bass</td>
<td>eight, tape</td>
</tr>
<tr>
<td>call</td>
<td>halt, home</td>
</tr>
<tr>
<td>cd</td>
<td>tv</td>
</tr>
<tr>
<td>down</td>
<td>balance</td>
</tr>
<tr>
<td>dvd</td>
<td>tv</td>
</tr>
<tr>
<td>eight</td>
<td>bass, tape</td>
</tr>
<tr>
<td>five</td>
<td>high</td>
</tr>
<tr>
<td>front</td>
<td>run</td>
</tr>
<tr>
<td>halt</td>
<td>call, home, pause, up</td>
</tr>
<tr>
<td>help</td>
<td>out</td>
</tr>
<tr>
<td>high</td>
<td>five, time</td>
</tr>
<tr>
<td>home</td>
<td>call, halt, phone</td>
</tr>
<tr>
<td>light</td>
<td>right</td>
</tr>
<tr>
<td>next</td>
<td>yes</td>
</tr>
<tr>
<td>off</td>
<td>office, up</td>
</tr>
<tr>
<td>office</td>
<td>off</td>
</tr>
<tr>
<td>on</td>
<td>arm</td>
</tr>
<tr>
<td>out</td>
<td>help</td>
</tr>
<tr>
<td>pause</td>
<td>halt</td>
</tr>
<tr>
<td>phone</td>
<td>home, zone</td>
</tr>
<tr>
<td>right</td>
<td>light</td>
</tr>
<tr>
<td>run</td>
<td>front</td>
</tr>
<tr>
<td>set</td>
<td>step</td>
</tr>
<tr>
<td>step</td>
<td>set</td>
</tr>
<tr>
<td>tape</td>
<td>bass, eight</td>
</tr>
<tr>
<td>time</td>
<td>high</td>
</tr>
<tr>
<td>tv</td>
<td>cd, dvd</td>
</tr>
<tr>
<td>up</td>
<td>halt, off</td>
</tr>
<tr>
<td>yes</td>
<td>next</td>
</tr>
<tr>
<td>zone</td>
<td>phone</td>
</tr>
</tbody>
</table>

The word pairs shown in Table 6-2 should also be avoided if possible. Although they have not demonstrated consistent unreliability, they could present potential problems depending on the environment in which the application is used. If any of these word pairs are chosen, be sure to experiment and test them thoroughly with a specific application.
Generally speaking, the more unique a word is in a library, the less likely it is to be incorrectly identified or misinterpreted for another word. Some shorter words are more difficult to recognize than longer words because they produce fewer vector codebook features during the sampling phase. An effective way to achieve high recognition accuracy is to not only avoid these words pairs but also to avoid short words.

### 6.3.2 Library Size

The number of words in a library also has an impact on recognition accuracy. As the size of the library increases, the probability of an error in recognition will gradually increase simply because there are more opportunities to create an error. It is recommended that all libraries be kept as small as possible. Since each customer application is unique, no one rule-of-thumb can be applied for all customers. Libraries as large as fifteen words have been shown to yield high accuracy. Depending on the words in a specific library, operating conditions and required accuracy, more or fewer words may be used.

---

**TABLE 6-2: WORD PAIRS TO USE WITH CAUTION**

<table>
<thead>
<tr>
<th>Word</th>
<th>Poorly Matched Words</th>
</tr>
</thead>
<tbody>
<tr>
<td>cd</td>
<td>dvd</td>
</tr>
<tr>
<td>clear</td>
<td>rear</td>
</tr>
<tr>
<td>door</td>
<td>four</td>
</tr>
<tr>
<td>dvd</td>
<td>cd</td>
</tr>
<tr>
<td>fan</td>
<td>scan</td>
</tr>
<tr>
<td>five</td>
<td>time</td>
</tr>
<tr>
<td>four</td>
<td>door, forward</td>
</tr>
<tr>
<td>forward</td>
<td>four</td>
</tr>
<tr>
<td>go</td>
<td>zone</td>
</tr>
<tr>
<td>high</td>
<td>pause</td>
</tr>
<tr>
<td>low</td>
<td>no</td>
</tr>
<tr>
<td>minutes</td>
<td>next</td>
</tr>
<tr>
<td>next</td>
<td>minutes</td>
</tr>
<tr>
<td>no</td>
<td>low</td>
</tr>
<tr>
<td>off</td>
<td>on</td>
</tr>
<tr>
<td>on</td>
<td>off</td>
</tr>
<tr>
<td>open</td>
<td>oven</td>
</tr>
<tr>
<td>oven</td>
<td>open</td>
</tr>
<tr>
<td>pause</td>
<td>high</td>
</tr>
<tr>
<td>rear</td>
<td>clear</td>
</tr>
<tr>
<td>scan</td>
<td>fan</td>
</tr>
<tr>
<td>seconds</td>
<td>seven</td>
</tr>
<tr>
<td>set</td>
<td>six</td>
</tr>
<tr>
<td>seven</td>
<td>seconds</td>
</tr>
<tr>
<td>six</td>
<td>set</td>
</tr>
<tr>
<td>time</td>
<td>five</td>
</tr>
<tr>
<td>zone</td>
<td>go</td>
</tr>
</tbody>
</table>
6.3.3 Application Design Tips

6.3.3.1 KEYWORD ACTIVATION

To make a robust application, it is recommended that the keyword activation feature be utilized. This can be done by calling `SR_Initialization()` using either `SR_Mode` 0 or 2. In these modes, the recognizer will be less likely to act on extraneous noises that may be incorrectly identified as a valid word. When the library is enabled, it is constantly sampling microphone data, and it is possible that an external noise adequately above the noise threshold will be recognized as a word in the library. Utilizing the keyword activation feature will minimize the chance of this happening when the system is idle.

6.3.3.2 SOFTWARE MENUS

Even though there is only one keyword, it is possible to add software menus to an application using a state machine. Figure 6-1 illustrates a state machine for a simple application that uses a seven-word library:

**TABLE 6-3: WORD LIBRARY FOR STATE MACHINE**

<table>
<thead>
<tr>
<th>Library Word</th>
<th>Control Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>control (keyword)</td>
<td>Enables the voice controlled user-interface</td>
</tr>
<tr>
<td>fan</td>
<td>Turns fan on</td>
</tr>
<tr>
<td>high</td>
<td>Switches fan speed to high</td>
</tr>
<tr>
<td>light</td>
<td>Toggles light on or off</td>
</tr>
<tr>
<td>low</td>
<td>Switches fan speed to low</td>
</tr>
<tr>
<td>off</td>
<td>Turns fan off</td>
</tr>
<tr>
<td>medium</td>
<td>Switches fan speed to medium</td>
</tr>
</tbody>
</table>

**FIGURE 6-1: RECOGNITION STATES**

In this application a light and fan are voice activated. The light is toggled on and off. The fan is turned on, and when it is on it can be switched to high, medium or low speed or switched off. When the application is powered up, it enters STATE 0 (Keyword Search mode), where it waits for the keyword to be uttered.
When the keyword ("control") is recognized, the application enters STATE 1 (LISTEN mode) and listens for another incoming word. A new word must be processed within the application defined timeout period or the application reverts to Keyword Search mode (STATE 0). In STATE 1, when the word “fan” is recognized, the fan is turned ON and control passes to STATE 2. When the word “light” is recognized, the light is toggled on or off and control passes to STATE 3.

STATE 2 responds only to the words “high”, ‘medium”, “low” and “off”. Any other word detected during STATE 2 is ignored. STATE 3 doesn’t respond to any word. When either of these states times out control reverts to STATE 0, which requires the keyword to be restated by the user. Each state prevents any false recognition by the library from affecting the application.
Appendix A. Master Library

A.1 Introduction

The master word library for the dsPIC30F Speech Recognition Library is a discrete list of 100 words from which vocabulary words can be chosen for a user application. Table A-1 lists the full possible vocabulary for the library.

**TABLE A-1: MASTER WORD LIST**

<table>
<thead>
<tr>
<th>Word</th>
<th>Word</th>
<th>Word</th>
</tr>
</thead>
<tbody>
<tr>
<td>alarm</td>
<td>help</td>
<td>resume (&quot;resume operation&quot;)</td>
</tr>
<tr>
<td>answer</td>
<td>high</td>
<td>reverse</td>
</tr>
<tr>
<td>arm</td>
<td>home</td>
<td>right</td>
</tr>
<tr>
<td>back</td>
<td>in</td>
<td>run</td>
</tr>
<tr>
<td>balance</td>
<td>intercom</td>
<td>scan</td>
</tr>
<tr>
<td>bass</td>
<td>left</td>
<td>seconds</td>
</tr>
<tr>
<td>brake</td>
<td>light</td>
<td>security</td>
</tr>
<tr>
<td>call</td>
<td>lock</td>
<td>select</td>
</tr>
<tr>
<td>camera</td>
<td>low</td>
<td>set</td>
</tr>
<tr>
<td>cancel</td>
<td>medium</td>
<td>seven</td>
</tr>
<tr>
<td>cd</td>
<td>minutes</td>
<td>shuffle</td>
</tr>
<tr>
<td>channel</td>
<td>motor</td>
<td>six</td>
</tr>
<tr>
<td>clear</td>
<td>mute</td>
<td>skip</td>
</tr>
<tr>
<td>close (&quot;close the book&quot;)</td>
<td>next</td>
<td>speaker</td>
</tr>
<tr>
<td>computer</td>
<td>nine</td>
<td>speed</td>
</tr>
<tr>
<td>control</td>
<td>no</td>
<td>start</td>
</tr>
<tr>
<td>cook</td>
<td>off</td>
<td>step</td>
</tr>
<tr>
<td>delete</td>
<td>office</td>
<td>stop</td>
</tr>
<tr>
<td>dial</td>
<td>okay</td>
<td>tape</td>
</tr>
<tr>
<td>disarm</td>
<td>on</td>
<td>temperature</td>
</tr>
<tr>
<td>door</td>
<td>one</td>
<td>three</td>
</tr>
<tr>
<td>down</td>
<td>open</td>
<td>time</td>
</tr>
<tr>
<td>dvd</td>
<td>out</td>
<td>track</td>
</tr>
<tr>
<td>eight</td>
<td>oven</td>
<td>treble</td>
</tr>
<tr>
<td>eject</td>
<td>pause</td>
<td>tv</td>
</tr>
<tr>
<td>e-mail</td>
<td>phone</td>
<td>two</td>
</tr>
<tr>
<td>fan</td>
<td>play</td>
<td>unlock</td>
</tr>
<tr>
<td>five</td>
<td>previous</td>
<td>up</td>
</tr>
<tr>
<td>forward</td>
<td>radio</td>
<td>volume</td>
</tr>
<tr>
<td>four</td>
<td>rear</td>
<td>yes</td>
</tr>
<tr>
<td>front</td>
<td>record (&quot;record the movie&quot;)</td>
<td>zero</td>
</tr>
<tr>
<td>go</td>
<td>redial</td>
<td>zone</td>
</tr>
<tr>
<td>halt</td>
<td>repeat</td>
<td></td>
</tr>
<tr>
<td>hangup</td>
<td>reset</td>
<td></td>
</tr>
</tbody>
</table>
Appendix B. Sample Libraries

B.1 Introduction

This appendix contains sample word libraries for these applications:

- Cell Phone Application
- Entertainment System Application
- Home Control Application
- Microwave Oven Application
- Security Control Application
- Stereo System Application

TABLE B-1: CELL PHONE APPLICATION

<table>
<thead>
<tr>
<th>Application:</th>
<th>Cell Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyword:</td>
<td>Phone</td>
</tr>
<tr>
<td>Word List:</td>
<td>Answer</td>
</tr>
<tr>
<td></td>
<td>Call</td>
</tr>
<tr>
<td></td>
<td>Dial</td>
</tr>
<tr>
<td></td>
<td>Digits (0-9)</td>
</tr>
<tr>
<td></td>
<td>Hang up</td>
</tr>
<tr>
<td></td>
<td>Home</td>
</tr>
<tr>
<td></td>
<td>Office</td>
</tr>
<tr>
<td></td>
<td>Redial</td>
</tr>
</tbody>
</table>

TABLE B-2: ENTERTAINMENT SYSTEM APPLICATION

<table>
<thead>
<tr>
<th>Application:</th>
<th>Entertainment System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyword:</td>
<td>Control</td>
</tr>
<tr>
<td>Word List:</td>
<td>CD</td>
</tr>
<tr>
<td></td>
<td>Channel</td>
</tr>
<tr>
<td></td>
<td>Digits (0-9)</td>
</tr>
<tr>
<td></td>
<td>DVD</td>
</tr>
<tr>
<td></td>
<td>Down</td>
</tr>
<tr>
<td></td>
<td>Eject</td>
</tr>
<tr>
<td></td>
<td>Mute</td>
</tr>
<tr>
<td></td>
<td>Play</td>
</tr>
<tr>
<td></td>
<td>Radio</td>
</tr>
<tr>
<td></td>
<td>Speaker</td>
</tr>
<tr>
<td></td>
<td>Stop</td>
</tr>
<tr>
<td></td>
<td>Tape</td>
</tr>
<tr>
<td></td>
<td>TV</td>
</tr>
<tr>
<td></td>
<td>Up</td>
</tr>
<tr>
<td></td>
<td>Volume</td>
</tr>
</tbody>
</table>
### TABLE B-3: HOME CONTROL APPLICATION

<table>
<thead>
<tr>
<th>Application:</th>
<th>Home Control</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyword:</td>
<td>Control</td>
</tr>
<tr>
<td>Word List:</td>
<td>Alarm, Cancel, Computer, Digits (0-9), Door, Fan, Help, Intercom, Light, Set, Temperature</td>
</tr>
</tbody>
</table>

### TABLE B-4: MICROWAVE OVEN APPLICATION

<table>
<thead>
<tr>
<th>Application:</th>
<th>Microwave / Oven</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyword:</td>
<td>Oven</td>
</tr>
<tr>
<td>Word List:</td>
<td>Clear, Cook, Digits (0-9), High, Low, Medium, Minutes, Pause, Seconds, Start, Stop</td>
</tr>
</tbody>
</table>

### TABLE B-5: SECURITY CONTROL APPLICATION

<table>
<thead>
<tr>
<th>Application:</th>
<th>Security Control</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyword:</td>
<td>Security</td>
</tr>
<tr>
<td>Word List:</td>
<td>Alarm, Arm, Camera, Cancel, Digits (0-9), Disarm, Lock, Resume, Scan, Set, Unlock, Zone</td>
</tr>
</tbody>
</table>
### TABLE B-6: STEREO SYSTEM APPLICATION

<table>
<thead>
<tr>
<th>Application:</th>
<th>Stereo System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyword:</td>
<td>Control</td>
</tr>
<tr>
<td>Word List:</td>
<td>Balance</td>
</tr>
<tr>
<td></td>
<td>Bass</td>
</tr>
<tr>
<td></td>
<td>Digits (0-9)</td>
</tr>
<tr>
<td></td>
<td>Down</td>
</tr>
<tr>
<td></td>
<td>Eject</td>
</tr>
<tr>
<td></td>
<td>Forward</td>
</tr>
<tr>
<td></td>
<td>Front</td>
</tr>
<tr>
<td></td>
<td>Left</td>
</tr>
<tr>
<td></td>
<td>Mute</td>
</tr>
<tr>
<td></td>
<td>Pause</td>
</tr>
<tr>
<td></td>
<td>Play</td>
</tr>
<tr>
<td></td>
<td>Record</td>
</tr>
<tr>
<td></td>
<td>Repeat</td>
</tr>
<tr>
<td></td>
<td>Reverse</td>
</tr>
<tr>
<td></td>
<td>Right</td>
</tr>
<tr>
<td></td>
<td>Shuffle</td>
</tr>
<tr>
<td></td>
<td>Skip</td>
</tr>
<tr>
<td></td>
<td>Speaker</td>
</tr>
<tr>
<td></td>
<td>Stop</td>
</tr>
<tr>
<td></td>
<td>Up</td>
</tr>
<tr>
<td></td>
<td>Volume</td>
</tr>
</tbody>
</table>
Index

A
Add Words ............................................................... 24

B
Background Noise.................................................... 19

C
Change Noise Profile ............................................... 24
Commands.................................................................... 25
Customer Notification Service................................. 6
Customer Support...................................................... 6

D
Delete Words ........................................................... 24
Documentation
   Conventions................................................................ 3
   Layout .......................................................................... 2

F
Free Software Foundation ......................................... 5

G
GNU Language Tools ................................................ 5

H
Hidden Markov Model ................................................. 13, 19
HMM. See also Hidden Markov Model

I
Internet Address........................................................ 5

K
Keyword File ............................................................. 19

M
Main Menu .................................................................... 25
Master Library ........................................................ 13, 14, 33, 35
Master Word List ......................................................... 33
Memory Profile .......................................................... 15
Microchip Web Site .................................................... 5

N
Noise Profile ............................................................. 13, 14, 19

P
Pre-defined Noise Profiles ......................................... 19

R
Reading, Recommended ........................................... 4
Readme......................................................................... 4
Re-Allocate Memory.................................................... 24

S
Signal-to-Noise Ratio ................................................ 13, 14, 19
SNR. See also Signal-to-Noise Ratio
Software Components............................................... 8
System Requirements................................................ 8, 9

T
Toolbar ......................................................................... 26

V
VCB. See also Vector Codebook
Vector Codebook ....................................................... 13, 14, 19, 22

W
Warranty Registration .................................................. 3
Word Library............................................................ 14
## WORLDWIDE SALES AND SERVICE

### AMERICAS
**Corporate Office**
2355 West Chandler Blvd.
Chandler, AZ 85224-6199
Tel: 480-792-7200
Fax: 480-792-7277
Technical Support: http:\support.microchip.com
Web Address: www.microchip.com

- **Atlanta**
  Alpharetta, GA
  Tel: 770-640-0034
  Fax: 770-640-0307
- **Boston**
  Westford, MA
  Tel: 978-692-3848
  Fax: 978-692-3821
- **Chicago**
  Itasca, IL
  Tel: 630-285-0071
  Fax: 630-285-0075
- **Dallas**
  Addison, TX
  Tel: 972-818-7423
  Fax: 972-818-2924
- **Detroit**
  Farmington Hills, MI
  Tel: 248-538-2250
  Fax: 248-538-2260
- **Kokomo**
  Kokomo, IN
  Tel: 765-864-8360
  Fax: 765-864-8387
- **Los Angeles**
  Mission Viejo, CA
  Tel: 949-462-9523
  Fax: 949-462-9608
- **San Jose**
  Mountain View, CA
  Tel: 650-215-1444
  Fax: 650-961-0286
- **Toronto**
  Mississauga, Ontario, Canada
  Tel: 905-673-0699
  Fax: 905-673-6509

### ASIA/PACIFIC
**Australia - Sydney**
Tel: 61-2-9868-6733
Fax: 61-2-9868-6755

- **China - Beijing**
  Tel: 86-10-8528-2100
  Fax: 86-10-8528-2104

- **China - Chengdu**
  Tel: 86-28-8676-6200
  Fax: 86-28-8676-6599

- **China - Fuzhou**
  Tel: 86-591-8750-3506
  Fax: 86-591-8750-3521

- **China - Hong Kong SAR**
  Tel: 852-2401-1200
  Fax: 852-2401-3431

- **China - Shanghai**
  Tel: 86-21-5407-5533
  Fax: 86-21-5407-5066

- **China - Shenyang**
  Tel: 86-24-2334-2829
  Fax: 86-24-2334-2393

- **China - Shenzhen**
  Tel: 86-755-8203-2660
  Fax: 86-755-8203-1760

- **China - Shunde**
  Tel: 86-757-2839-5507
  Fax: 86-757-2839-5571

- **China - Qingdao**
  Tel: 86-532-502-7355
  Fax: 86-532-502-7205

### ASIA/PACIFIC
**India - Bangalore**
Tel: 91-80-2229-0661
Fax: 91-80-2229-0662

- **China - New Delhi**
  Tel: 91-11-5160-8632
  Fax: 91-11-5160-8632

- **Japan - Kanagawa**
  Tel: 81-45-471-6166
  Fax: 81-45-471-6122

- **Korea - Seoul**
  Tel: 82-2-554-7200
  Fax: 82-2-558-5932 or 82-2-558-5934

- **Singapore**
  Tel: 65-6334-8870
  Fax: 65-6334-8850

- **Taiwan - Kaohsiung**
  Tel: 886-7-536-4818
  Fax: 886-7-536-4803

- **Taiwan - Taipei**
  Tel: 886-2-2500-6610
  Fax: 886-2-2508-0102

- **Taiwan - Hsinchu**
  Tel: 886-3-572-9526
  Fax: 886-3-572-6459

### EUROPE
**Austria - Weis**
Tel: 43-7242-2244-399
Fax: 43-7242-2244-393

- **Denmark - Ballerup**
  Tel: 45-4420-9895
  Fax: 45-4420-9910

- **Germany - Ismaning**
  Tel: 49-89-627-144-0
  Fax: 49-89-627-144-44

- **France - Massy**
  Tel: 33-1-69-53-63-20
  Fax: 33-1-69-30-90-79

- **England - Berkshire**
  Tel: 44-118-921-5869
  Fax: 44-118-921-5820

09/27/04